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1. Introduction 

We would like to present a handy and flexible program that allows you to relate the data to location as 
regards the districts. It is effective in supporting commercial, marketing, and market analyses, customer 
analyses, demographic and statistical analyses. Its universal character, being embedded in MS Excel 
environment and its capability of connecting to other files make it a program that can be used by 
companies and organizations of any specialization. 

The manual gives you step-by-step instructions for working with the program and creating charts in it. 
Despite also providing some general instructions concerning said charts and their use (in particular the 
choropleth map), the manual is not a compendium of knowledge concerning creation of charts, but only 
guidelines of how to construct them within the program. 
 
The instructions contain the following designations: 

! Important 

V Tip 

 
The code used by the program has been secured with the VBA editor preventing recording macros in the 
program. It is however possible to record macros via another workbook and save it in another file. 
 
Both, the program and this instructions manual are protected with copyrights, provisions of international 
conventions and other acts on protection of intellectual property rights. 

 
You can get help in program operation at contact@maps-for-excel.com or +48 500 196 861. 

2. Requirements 

a. MS Excel 2007 or newer  
The program is in the format of the MS Excel workbook with the .xlsm extension. In order to use it you 

need MS Office suite, version 2007 or newer, the 2010 or newer version being recommended due to its 
more stable and complex graphics engine. Installation of the program is not necessary. 
 
b . Macros enabled  

The program is based on the VBA code, therefore macros must be enabled for its correct operation. It can 
be done every time when starting the program or permanently by entering File > Options > Trust Center 
> Macro Settings. Frequent saving of a backup copy is recommended when working with the program. 
 

! Operations performed with macros cannot be undone. 
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c. Intermediate Excel skills   
To use the program correctly one must have intermediate Excel knowledge, in particular regarding 
navigation areas, shapes editing, cell formatting, and search functions. Using the basic function, the 
choropleth map, should not be problematic for users with basic Excel skills. 

 

3. Program versions 

The program has 3 versions: Basic, Standard, and Premium, with varying numbers of functions. The 
manual contains descriptions of all functions. 
 

 

4. Functions 

a. Choropleth map  

The choropleth map is a chart displaying the intensity of a given phenomenon in individual areas with 
changing hues, based on a map whose reference point is the legend placed below the map. 

 

 
 

! The key to achieve satisfactory and reliable results when creating a choropleth map is definition of 

ranges (so-called classes) that should be preceded by the analysis of statistical distribution. Modification of 

ranges is of utmost importance for what is displayed in the chart and how the chart is interpreted. 

 
V When creating choropleth maps for Recipient without any knowledge of the statistics, the best solution 

are ranges equal in respect of the size and number of elements. 
  
In order to construct a choropleth map in the program: 

1. Enter data into the Data spreadsheet, cells C2-C17 for states (German: Land) or E20-E21 for 
districts (German: Kreis). 

2. Enter ranges for values in the chart, J2-J11, starting from minimum, finishing with maximum. The 
ranges will appear in cells L2-L12. 

3. Switch on/off the visibility of states in the Map spreadsheet by uncovering/covering the shape in 
the window Home > Find & Select > Selection Pane > Land. 

4. Click Update in the right column of the Map spreadsheet. 

 

! The entered data must have numeric format or the cells should remain empty. When other formats are 

entered (e.g. text or error) and Update is clicked, the program will display an error message. 

http://maps-for-excel.com/wp-content/uploads/2013/10/Excel-Map-Germany-Basic.png
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V In order to connect your data (source data) you can use the search function, e.g. VLOOKUP. If this 

function does not find the searched value, it displays error, so it should be used in connection with the IF 
and ISERROR functions. Moreover, a few districts have the same name, so the source data should include 

a column containing district name and type, and a column with the value =Kreis&Type: 
 

  
 

An example of connecting data for the E20 cell (Data spreadsheet) to Example spreadsheet: 
=IF(ISERROR(VLOOKUP(A20&B20;Example!C:D;2;0));””; VLOOKUP(A20&B20;Example!C:D;2;0)) 
 

 
 

Belonging of a district to a state can be emphasized by leaving just the outlines of states. In such case a 
no fill option should be set for the shape of the state grouped in the Selection Pane. 
 

      
 

 
The color palette (legend) of a choropleth map includes 11 elements. 

 
V It is due to the fact that the human eye can differentiate between 5 hues of any given color. 

 

The elements of the choropleth map can have one color (e.g. blue) of different hues (sequential color 
scheme) or two colors (diverging color scheme). 

 
V The red and blue palette is default due to its broadest use and intuitive understanding. 

 
The legend displayed in the Map spreadsheet is connected with the data in the Data sheet. It is formatted 
(e.g. its numbers) the same way as regular cells. 
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User can select other palettes from a list in the Map spreadsheet. 
 

 
 
It is also possible to edit the list in the Palette spreadsheet by entering RGB codes into columns B to L. The 
RGB code is a number signifying a given color that can be obtained by entering values describing the 
colors of the new palette (Red, Green, Blue) in the B13-D22 cells of the Palette sheet. The RGB code 
appears in the column E. Then the obtained numbers should be copied into columns B to L in place of the 
unwanted palette. When Update is clicked in the Map spreadsheet both, the legend and chart will be 

colored as intended. 

 
 
The RGB code can be obtained by selecting a color that interests us from MS Excel color palette and 
reading its RGB values. 
 

 
 
 

b . Bubble chart  

A bubble chart is a diagram showing 3 dimensions of a phenomenon at the same time, placed on the axes 

X and Y, and as a bubble size. In the program the bubble chart uses locations coordinates as X and Y 
values, leaving the control of the bubble size to the user.  
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In order to construct a bubble chart for states one must enter a number value into column D of the Data 

spreadsheet, and for districts into column F. It automatically updates the Map tab where it remains to 
switch on the bubble chart in the Selection Pane (Home > Find & Select > Selection Pane > Bubble). 
 

  
 

   
 
The list of locations in the City spreadsheet contains cities-administration seats of all districts. The position 

of each location in the chart is defined by longitude and latitude. Searching the Data spreadsheet is done 
with the aid of the VLOOKUP function. Data can be entered directly into the City sheet, column E. 
 
The list of locations can be freely edited (changing names of locations, correcting their coordinates) by 
replacing locations on the list with new ones. One must keep in mind, however, that data labels on the 
bubble chart are not updated automatically. It means that after changing a name or introducing another 
name, the label of the data point must be attributed manually by clicking a given label and entering the 

name into the formula box. 
 
The position of bubble labels can be edited with the right mouse button > Format Data Labels > Label 
Options > Label Position. 
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c. Advanced bubble chart  
The bubble chart within the program allows to add the fourth dimension of data (besides longitude, 
latitude and bubble size), which is represented graphically with the color varying from dark red to dark 
blue. For example, the amount of sales in a given location can be represented as the size of the bubble 

and the profit as its color. 
 

 
 
Before the data is entered, the values of the Data spreadsheet should be removed from column C for 

states and E for districts (Value column), as coloring areas cannot be combined with the advanced bubble 
chart because of their common color palette. 
 

To create an advanced bubble chart enter numeric values into the Data spreadsheet, column E or G for 
state capitals and administrative seats of districts respectively. Then enter range data into the Data sheet, 
cells J2-J11. And then switch on the Bubble chart coloring option in the Map spreadsheet by clicking On. 
 

  
 
The bubble chart color palette is fixed and can be edited only manually changing the color of each bubble 
chart series. 
 

The advanced bubble chart function allows for editing the bubble chart size with a slide control located in 
the Map spreadsheet. 

 

 
 
In addition the chart contains a macro automatically updating names of locations in the chart (bubble 

labels). In order to use it change names in the City spreadsheet, column B > highlight the bubble chart in 
the Map sheet by clicking it > Click the Alt+F8 key combination > start the “Przypisz_etykiety” macro. 
 
 

 
 

d . District name and value message  

Upon clicking on the district area with the left mouse button we receive a message informing of the exact 
value in the chart: 
 

 
 

To change the format of the numbers displayed in the message modify the J7 cell in the Control 
spreadsheet by entering the number format there after the apostrophe, e.g. for % it would be: ‘0%, for 

Bubble chart coloring

Bubble size
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integers: ‘0. More formats can be found in the Format cells window (right-click on any cell > Format Cells 
> Number > Custom). 
 

e. Postal codes  

The postal codes function allows to depict on the map the numeric values assigned to postal codes of 
respective districts. The ZIP spreadsheet contains the list of more than 8 000 postal codes of states and 
districts. The ZIP_Assign spreadsheet contains a table where data should be entered into columns A and B, 
leaving C and D empty. Then click Assign assigning codes to districts and adding the column B values for 

each district. Correct assignment is marked green in column C. After clicking Draw the data is transferred 
to the Map spreadsheet and the map updated. 
 

 
 

f . Indicators of the  Statistische s Bundesamt  
To expand the possible interpretations the available data can be related to the data of the Statistisches 

Bundesamt. The basic indicators from the database of the Statistisches Bundesamt have been included in 
the Stats spreadsheet. For example, to calculate sales per 1 inhabitant divide the sales data for each 
district by the data from column D, the Stats spreadsheet. 
 

 
 

g . Controlling the choropleth map  
The controlling button placed in the Map spreadsheet allows for a dynamic change of the range of district 
data with one click. Before using it one must fill in the Button spreadsheet with data entering a few data 

series for each district including names in the first line (=“” should be entered into the headline of the 
unused column), and then start the Activate button option. 
 

 
 
To change the data range for the choropleth map select the correct option from the control button in the 
Map spreadsheet. 

 

 
 

5. Frequently asked questions 

a. How do I reduce the number of the legend elements, e.g. to 4?  
To reduce the number of elements in a legend two actions are needed. First, ranges must be modified in 
order for the program to work properly. To this end enter 3 first values with the last one greatly exceeding 
the highest value in our data. 
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Then remove unnecessary legend elements from the Map spreadsheet and correct descriptions. 
 

 
 

b. How do I increase the number of the legend elements, e.g. to 20?  

Increasing the number of legend elements requires programming and is a pay service. 

c. How do I color areas according  to  my own division?  
The map can be used to draw your own division, e.g. sales regions. Areas should then be assigned 
successive numeric values (e.g. 1, 2, 3, etc.) and ranges matched to them. 

 

  
 

d. How do I hide some areas and enlarge the rest?  

The map consists of separate elements that can be hidden irrespective of one another. Hiding and 
uncovering the shapes is done in the Selection Pane of the Map spreadsheet. The shapes can be then 

grouped and enlarged by selecting a few shapes > right-clicking on them with the mouse > Group > 
Group. If the shapes are grouped they must be ungrouped. 
 

 
 

Bins Bins on map

Min 10 < 10

20 < 20

30 < 30

1000000 < 1000000

1000000 < 1000000

1000000 < 1000000

1000000 < 1000000

1000000 < 1000000

1000000 < 1000000

Max 1000000 < 1000000

>= 1000000

> 30

20 - 30

10 - 20

< 10

tǊȊŜŘȊƛŀƱȅtǊȊŜŘȊƛŀƱȅ ƴŀ ǿȅƪǊŜǎƛŜ

2 < 2

3 < 3

4 < 4

5 < 5

6 < 6

7 < 7

8 < 8

9 < 9

10 < 10

11 < 11

>= 11
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e. How do I export the map to other programs?  
The map is inserted as a shape (image) and can be edited only as such. Standard chart formatting tools, 
in particular the Embed cannot be applied. To transfer the map to another program (e.g. MS Word, MS 
PowerPoint) select the cells of the spreadsheet (not the shapes) and insert them as an image or use the 

screenshot option available in the Insert toolbar. 
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6. Examples 
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